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Introduction

Sequence Creation Software SD025-PMX Wavy for PMX is a software application that is used to cre-
ate and execute sequences on PMX Series regulated DC power supplies. This operation guide
explains how to use Sequence Creation Software SD025-PMX Wavy for PMX to control PMX Series
regulated DC power supplies.

 Applicable version 

This operation guide applies to version 6.x of SD025-PMX Wavy for PMX. To find out the version
of the Wavy for PMX, click on the [Help] menu and select [About Wavy].

 Intended readers of this operation guide

This operation guide is intended for users who will use SD025-PMX Wavy for PMX to control DC
power supplies and instructors of such users.

It assumes that the reader has knowledge about electrical aspects of DC power supplies.

 Trademarks

Microsoft and Windows are trademarks of Microsoft Corporation in the United States and/or
other countries.

All other company and product names used in this guide are trademarks or registered trade-
marks of their respective owners.

 Notations used in this guide

• In this guide, SD025-PMX Wavy for PMX is referred to as ”Wavy for PMX“ or “Wavy.”
PMX Series regulated DC Power Supply is referred to as the “PMX Series.”

• The term “PC” means both personal computers and workstations.

• The following markings are used in this guide.

Indicates information that you should know.
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Configuring the Interface

You need to configure the interface before using Wavy.

Using the RS232C interface

 Configuration on the PMX series

1 Turn the POWER switch on of the PMX Series.

2 Make sure that the PMX output is off.

3 Press [CONFIG] key twice.
The voltmeter displays “CF20.”

4 Turn [CURRENT] knob to select [232].

5 Press [LOCAL] key.
The PMX series exits from CONFIG settings.

6 Turn off the PMX series and then back on.

7 Connect the PMX series to your PC.

 Configuration of Wavy

8 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

9 Select the connected PMX Series from the [Instrument].
The maximum value that can be specified on Wavy is limited to 105 % of the rated output
of the selected model. Select the correct model. For example, if you select PMX35-1A, you
will not be able to set values exceeding 36.75 V (35 x 1.05).

10 Select [RS232C].
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Configuring the Interface

11 Set the [COM Port (COM1to COM20)].

12 Click [Test] to verify that your PC is communicating with the PMX Series.
The protocol on the PMX series side is fixed. It is set as follows:

Baudrate: 19200 bps, Data bit: 8 bits, Stop bit: 8 bits, Parity bit: none, 
and X-flow control: off

Wavy exchanges data according to the above protocol settings. There is no need to manu-
ally change them on the PC side.

13 Click [OK].
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Configuring the Interface

Using the USB interface

 Configuration on the PMX series

1 Turn the POWER switch on of the PMX Series.

2 Make sure that the PMX output is off.

3 Press [CONFIG] key twice.
The voltmeter displays “CF20.”

4 Turn [CURRENT] knob to select [uSb].

5 Press [LOCAL] key.
The PMX series exits from CONFIG settings.

6 Turn off the PMX series and then back on.

7 Connect the PMX series to your PC.

 Configuration of Wavy

8 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

9 Select the connected PMX Series from the [Instrument].
The maximum value that can be specified on Wavy is limited to 105 % of the rated output
of the selected model. Select the correct model. For example, if you select PMX35-1A, you
will not be able to set values exceeding 36.75 V (35 x 1.05).

10 Select [USB].

11 Select the serial number of the PMX Series in [Serial Number].
You can confirm the serial number on the rear panel of the PMX Series.

If the serial number is not displayed even when the PMX series is connected properly, ver-
ify that the PMX Series is being recognized on your PC. In the Control Panel, click [System
and Security]. Then, click [Device Manager] under [System].
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Configuring the Interface

Verify if “USB Test and Measurement Device” is indicated. If the device does not appear in
the [Device Manager], reinstall VISA.

12 Click [Test] to verify that your PC is communicating with the PMX Series.

13 Click [OK].

When the PMX Series suddenly becomes unrecognized

When the PC enters sleep mode, it may stop recognizing the PMX Series. In such a case, disconnect
the USB cable once and reconnect it.
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Configuring the Interface

Using the LAN interface

 Configuration on the PMX series

1 Turn the POWER switch on of the PMX Series.

2 Make sure that the PMX output is off.

3 Press [CONFIG] key twice.
The voltmeter displays “CF20.”

4 Turn [CURRENT] knob to select [LAn].

5 Press [CONFIG] key.

6 Turn the VOLTAGE and CURRENT knobs to set the protocol.
Set DHCP (CF30) and AUTO IP (CF31) to “on.”

7 Press [LOCAL] key.
The PMX series exits from CONFIG settings.

8 Turn off the PMX series and then back on.

9 Connect the PMX series to your PC.

 Configuration of Wavy

10 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

11 Select the connected PMX Series from the [Instrument].
The maximum value that can be specified on Wavy is limited to 105 % of the rated output
of the selected model. Select the correct model. For example, if you select PMX35-1A, you
will not be able to set values exceeding 36.75 V (35 x 1.05).

12 Select [Ethernet].
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Configuring the Interface

13 From [IP Address], select the IP address of the connected PMX series.
To find out the IP address, refer to the CONFIG settings (CF35 to CF38) on the PMX Series.
For more details, see the PMX Series user’s manual.

 p. 9
If the IP address is not displayed even when the PMX series is connected properly, you
need to search for the device connected through LAN using the VISA library.

14 Click [Test] to verify that your PC is communicating with the PMX Series.

15 Click [OK].

When the PMX Series suddenly become unrecognized

When you are not using a fixed IP address, the IP address of the PMX Series may change. If the PMX
Series suddenly become unrecognized, confirm the IP address by checking the CONFIG settings
(CF35 to CF38) on the PMX Series. If the IP address has been changed, re-enter the update IP
address in the [IP Address].

Searching for the device connected through LAN

The following procedure is for when KI-VISA is used for the VISA library. If you are using another
VISA library, see the corresponding manual.

1 On the task bar, click Start, All Programs, Kikusui IO Software, KI-VISA, and
then Instrument Explorer.
Instrument Explorer will start.

If “Instrument Explorer” is not displayed in the Start menu or the desktop, open KiVisa-
Exp.exe in the following folder.

64 bit OS: C:\Program Files\IVI Foundation\VISA\VisaCom64\KiVisa

32 bit OS: C:\Program Files (x86)\IVI Foundation\VISA\VisaCom\KiVisa

2 Click [KI-VISA IO Config].

3 Click the [LAN] tab.
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Configuring the Interface

4 Select the [Enable dynamic search for active instruments] check box.

5 Click [OK].
The KI-VISA IO Config window opens.

6 Check that the IP address of the connected PMX series appears in the tree on
the left side of the Instrument Explorer window, and close Instrument
Explorer.

You can now select the IP address in the Wavy’s [Interface] window. 
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Screen Overview

Sequence Setup window

When you start Wavy, a main window comprising [Graph] and [Worksheet] windows appears. 

In the [Graph] window, you can set the steps by drawing lines with a mouse.

In the [Worksheet] window, you can set the steps by entering the values.

Graph window Sheet window
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Screen Overview

Sequence Execution window

This window is used to execute sequences. You can display three types of graphs using the tabs.

Tab Display

Setting Graph A graph of the sequence to be executed appears.

Monitor Graph
A real-time monitor graph that graphs monitored voltages and cur-
rents while executing a sequence appears.

Setting/Monitor Graph
A graph of the sequence to be executed appears in the top half, and a 
real-time monitor graph appears in the bottom half.

Setting Graph

Click the tab to show in the window.
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Overview of Sequence Creation

A sequence is a feature that automatically executes the predefined steps in a given order. You can
simulate various waveforms.

A sequence comprises multiple steps, which will be executed in a given order. A single sequence
can comprise up to 1024 steps. The execution of the last step normally concludes the sequence. If
you set the repetition count of a sequence, however, the sequence will be repeatedly executed until
it reaches to the last count. 

Sequence execution procedure

Time

Sequence

100 seconds
Ramp

150 seconds
Step

80 seconds
Ramp

Step 1 Step 3Step 2

Set the operating conditions for the sequence.

• Sequence settings

• Setting the Operating Mode

• Setting Protection Functions

• Setting the Sequence Repetition Count

Set the operating conditions for the steps.

• Step settings

• Creating or Editing Steps by Drawing

• Creating and Editing Steps by Entering Values

• Saving and Loading Sequence

Execute the sequence.

• Executing Sequences

• Saving Monitored Data
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Sequence Settings

Sequence settings

For a sequence, you need to set the following conditions common for all steps.

• Operating mode (Constant Voltage (CV) or Constant Current (CC))
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Set the operating mode. The current/voltage limit can also be specified.

• Protection settings
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Configure the protection settings.

• Repetition count
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Set how many times to repeat the sequence.

• Step interval

 p. 25
Configure the step interval unit.

Step settings

For each step, you need to configure a set of values as shown in the figure below. 
One step corresponds to one operation in a waveform to be executed.

Time [s] indicates the accumulated time from the beginning, which is unable to be modified.

• Voltage (in CV mode)

Set the voltage when Constant Voltage (CV) mode being enabled.

• Current (in CC mode)

Set the current when Constant Current (CC) mode being enabled.

• Interval

Set the execution time for the step.

The maximum value that can be specified on Wavy is limited to 105 % of the rated output of the 
PMX series specified by [Instrument] in the interface window. For example, if you specify PMX35-1A, 
you will not be able to set values exceeding 36.75 V (35 x 1.05).

Sheet window in CV mode Sheet window in CC mode
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Sequence Settings

• Transition (Step or Ramp)

Set the transition type for the step.

The resolution of ramp transition is 50 ms to 100 ms.

When the step interval is limited, the ramp line may not be linear.

• Output (on or off )

Switch on/off of the output.

You can edit the steps by either drawing lines in [Graph] window or entering values in [Worksheet]
window.

(Example 1)   Current:10 A
       Transition: Step

(Example 2)  Current: 10 A
                      Transition: Ramp

1 step

10 A

1 step

10 A

1 step

10 A

As shown in the figure below,
the ramp transition is at a given resolution.

50 ms to 100 ms
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Setting the Operating Mode

Select the operating mode among two modes:  constant voltage (CV) or constant current (CC)
mode.

1 Click on the [Sequence] menu and select [Sequence Creation Mode]. Or, click
 on the toolbar.

The [Sequence Creation Mode] window opens.

2 To use the PMX series in constant-voltage mode, select [Constant Voltage]. To
use it in constant-current mode, select [Constant Current].

3 Enter the limited current (for CV mode) or limited voltage (for CC mode).
There are three significant decimal places (x.xxx). The actual number of significant deci-
mal places varies depending on the PMX Series to which the PC is connected.

4 To monitor the activation of protection functions during sequence execution,
select the [I confirm the state of the protection every four seconds] check box.

5 Click [OK] to close the window.
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Setting Protection Functions

You can enable the protection functions by setting one of two protection functions:  [Power Supply
Setting] and [Soft Setting].

 Power Supply Setting

These are the protection functions incorporated in PMX Series regulated DC power supply.

You can set overvoltage protection (OVP), and overcurrent protection (OCP).

 Software Setting

These are the protection functions which Wavy for PMX activates on the basis of monitored
data.

You can set overvoltage protection (OVP), overcurrent protection (OCP), undervoltage protec-
tion (UVP), and undercurrent protection (UCP).

Using the protection functions on PMX Series (Power Supply Setting)

1 Click on the [Sequence] menu and select [Protection Setup].
The [Protection Setup] window opens.

2 Enter the values of the overvoltage protection and the overcurrent protection.

3 Click [Write].
The settings are transmitted to PMX Series and becomes activated.

4 Click [OK] to close the window.

Querying the PMX Series settings

To query and load the present protection settings on the connected PMX Series, click [Read].
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Setting Protection Functions

Using the protection functions of Wavy (Software Setting)

When the overvoltage protection or the overcurrent protection being activated, the sequence exe-
cution stops if the monitored values equal or exceed the set values.

When the undervoltage protection or undercurrent protection being activated, the sequence exe-
cution stops if the monitored values fall below the set values.

1 Click on the [Sequence] menu and select [Protection Setup].
The [Protection Setup] window opens.

2 Select the protection function to activate.
While the function being selected, you can enter the value in the text box.

3 Enter the values in the text boxes.
Even when you enter protection values, if you clear the check boxes, the protection func-
tions will be disabled.

The maximum values that you can enter do not depend on the rated output of the con-
nected PMX series.

4 Click [OK] to close the window.

Ignoring the first monitored values

If the unstable values from the initial monitoring is used, the sequence execution may be
aborted due to the protection function. If the [Ignore the first monitored values] check box is
selected, sequence execution will continue even if the first monitored values are above or
below the protection values.



SD025-PMX Wavy for PMX 19

Setting the Sequence Repetition Count

Set the repetition count of the sequence.

1 Click on the [Sequence] menu and select [Sequence Creation Mode], or click
 on the toolbar.

The [Sequence Creation Mode] window opens.

2 Set the repetition count (between 1 and 9999, or Infinity).

3 Click [OK] to close the window.
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Creating or Editing Steps by Drawing

Creating the Steps

You can create the steps in the [Graph] window.

1 Move the pointer over the Y axis.
The pointer changes to a crosshair, and the voltage (in CV mode) or the current (in CC
mode) is indicated.

2 Drag the pointer to the point where the desired time (on X axis) and the
desired current/voltage (on Y axis) meets. 
The setting is committed when you release the mouse button, and the corresponding val-
ues are automatically entered in the first line of the [Worksheet] window.

 p. 25, p. 26
You can change the scale of the graph and/or step interval unit.

3 To add the step, move the pointer over the end point of the previous step.
Once the pointer changes to a crosshair, drag the pointer to the desired point.
The setting is committed when you release the mouse button, and the corresponding val-
ues are entered in the following line of the [Worksheet] window.

Repeat the procedure until you complete creating all the steps.

Graph window

Place the pointer on Y axis 
and click.

Drag

Release the mouse button at the 
desired point to commit the step. 

Step-division line
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Creating or Editing Steps by Drawing

Editing the steps

Changing the voltage or current setting

1 Double-click the step line to edit.

The end point changes to a black square (), which indicates that you can edit the step.

2 Move the pointer over the black square ().
The pointer changes to a pair of vertical arrows.

3 Drag the pointer vertically until it reaches to the desired point.
The setting changes.

Drag
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Creating or Editing Steps by Drawing

Changing the interval (step execution time)

1 Double-click the vertical line (step-division line) that lies at the end point of
the step to edit.

The top of the step-division line changes to a black square (), which indicates that you
can edit the step.

2 Move the pointer over the black square().
The pointer changes to a pair of horizontal arrows.

3 Drag the pointer horizontally to the desired point.
The setting changes.

Changing transition (Step or Ramp)

1 Double-click the step line to edit.

The top of vertical line (step-division line) changes to a black square (), which indicates
that you can edit the step.

2 Right-click and select [Transition] from the context menu, then point to [Ramp]
or [Step].
The transition of the step changes.

Deleting the steps

1 Double-click the step line to delete.

The top of vertical line (step-division line) changes to a black square (), which indicates
that you can edit the step.

2 Right-click and select [Delete].
The step is deleted.

Drag
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Creating and Editing Steps by Entering Values

Creating the Steps

Ypu can create the steps in the [Worksheet] window.

The first row in the [Worksheet] window represents step 1. Time [s] indicates the accumulated time
from the beginning and cannot be modified.

To edit the voltage, current, and interval, click the applicable cell and enter the value.

To edit the transition and output, double-click the applicable cell, or click the cell and press Enter
key. By default, the [Transition] is set to “Step”, and the [Output] is set to “on”. Once set, the [Transi-
tion] and [Output] settings cannot be deleted. To delete these settings, you need to delete the
whole step.

You can cancel the edit by pressing Esc key in the middle of entering the values.

Start entering data for step 1 and continue for the following steps in order.

Step 1
Step 2
Step 3

Time cannot be modified.
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Creating and Editing Steps by Entering Values

Copying and deleting the steps

You can delete and copy the steps in the [Worksheet] window.

Also, you can undo the operation once. To undo the last operation, right-click on the [Worksheet]
window and select [Undo].

Inserting a copy of a step

1 Click a cell in the step to copy.
You can click any cell in the step that you are going to copy.

You can select consecutive rows by holding down the Shift key.

2 Click on the [Worksheet] menu and select [Copy]. Or, right-click on the [Work-
sheet] window and select [Copy] from the context menu.

3 Select any cell in the step.

4 Click on the [Worksheet] menu and select [Paste]. Or, right-click on the [Work-
sheet] window and select [Paste] from the context menu.
The copied step is inserted above the selected step.

Deleting a step

1 Click a cell in the step to delete.
You can click any cell in the step that you are going to delete.

You can select consecutive rows by holding down the Shift key.

2 Click on the [Worksheet] menu and select [Delete]. Or, right-click on the [Work-
sheet] window and select [Delete] from the context menu.

The deleted step is temporarily copied to the clipboard. Thus, if you select [Paste] command right
after deleting the step, the deleted step will be inserted.

Keyboard shortcuts

You can use keyboard shortcuts on the [Worksheet] window.

Operation Shortcut keys

Copy steps “C” or “Ctrl + C”

Insert a step*1

*1. A confirmation dialog appears before execution.

“V” or “Ctrl + V”

Delete steps1 “Delete”

Undo1 “Z” or “Ctrl + Z”

Select all rows “A” or “Ctrl + A”
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Changing the Step Interval Unit

You can set the step interval unit to seconds, minutes, or hours.

1 Click on the [Sequence] menu and select [Sequence Creation Mode]. Or, click

 on the toolbar.

The [Sequence Creation Mode] window opens.

2 Select the unit from the [Unit] drop-down menu.
If there is step data in the [Worksheet] window, you cannot change the unit.

3 Click [OK] to close the window.

Unit Interval setting range Setting resolution

s (seconds) 0.5 s to 999.5 s 0.5 s

min (minutes) 0.1 min to 999.9 min 0.1 min

h (hours) 0.1 h to 999.9 h 0.1 h
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Changing the Setting Graph Scale

You can change the scale on X-axis and Y-axis in the [Graph] window.

Select the [Graph] window, click on the [Graph] menu, and select [Scale]. Or, click  on the
toolbar. Then, the [Scale] window opens. You can also right-click on the [Graph] window and select
[Scale] to open the window.

If you select the [Maximum Time], [Maximum Value], or [Minimum Value] check box, the auto scal-
ing function is enabled. While the auto scaling function being enabled, the scale is automatically
adjusted to create steps or open a saved file.

When the auto scaling function is disabled, the value beyond the range does not appear in the
graph.

When you are creating steps by drawing, however, the scale is not automatically adjusted. In this
case, click on the [Graph] menu and select [Update Auto Scale] to update the scale.
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Saving and Loading Sequence

After creating the sequence data, you can save the data to a file.

Saving files

To newly save the data to a file, click on the [File] menu and select [Save As]. 

To overwrite the file, click on the [File] menu and select [Save], or select  on the toolbar. In
either case, the file will be saved with extension “wvy”.

 Viewing the saved data

You can open the saved file in Notepad.
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By default, the data is saved as tab-separated values. You can select comma-separated values in
the [Environment Setup] window.

• First row in the data

• Second and subsequent rows in the data

Loading the file

You can load the saved data.

Click on the [File] menu and select [Open], or click  on the toolbar.

1st column PMX Series name
2nd column File version

3rd column
CV Constant voltage mode
CC Constant current mode

4th column N Always “N”

5th column
s seconds
min minutes
h hours

6th column Repetition count

7th column
Limited current (in CV mode)
Limited voltage (in CC mode)

1st column Voltage value or current value
2nd column Interval Unit is indicated in the first row.
3rd column Transition 0:  Step, 1:Ramp
4th column Output 0:Off, 1:On
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Executing Sequences

Once you complete creating all the steps, you can move on to the sequence execution.

1 Click on the [Sequence] menu and select [Run], or click  on the toolbar.
The [Run] window opens.

2 Click [Run].
The sequence is executed.

To abort the sequence in progress, click [Stop]. 

The green line roughly indicates the position being executed. When the sequence is
repeated for many times or the sequence is rather longer, however, the green line indica-
tion may not be stable. 

During the sequence execution, you cannot use the menus and the toolbar or change the
window size.

 Turning the output off when a sequence completes

If you select the [Output OFF when End/Stop] check box, the output will be automatically turned
off when the sequence execution is complete or aborted, or when the protection function is acti-
vated.

If this check box is not selected, you need to turn off the output manually. To turn off the output,
click the [OFF] under the [OUTPUT OFF when End/Stop] check box. While the sequence being in
progress, [OFF] is disabled.
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Executing Sequences

 Specifying the time to execute the sequence

To specify the time to execute the sequence, select the [Execute at the specified time] check
box. In the opened dialog, enter the target time (year, month, day, hour, minute, second) to exe-
cute the sequence.

Information indicated during the sequence execution

 Status indicator

During the sequence execution, one of the following status is indicated in the [Run] window.
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Performing a long sequence increases the data to be displayed in the real-time monitor graph. By
setting the maximum data amount, you can reduce the load to PC. Even if you set the maximum
data size, all monitored data will be saved.

CC / CV
In constant current (CC) mode, the box next to CC turns to red.
In constant voltage (CV) mode, the box next CV turns to green.

Count Displays the latest count of the sequence repetition.

Step Displays the step being executed at the moment.

Elapsed Time Displays the elapsed time since the sequence execution started.

Voltage/Current
Displays the item (current, voltage) that you selected by clicking [Sequence] 
and then [Monitoring Setup].

The PMX Series is ready to start.

The sequence is being executed.

The sequence is complete.

The [Stop] button has been clicked.

A communication error has occurred. Verify the interface settings.

(In case of OVP)

A protection function has been activated.*1

OVP: Overvoltage protection, OCP:  Overcurrent protection, UVP: Under-
voltage protection, UCP: Undercurrent protection, OHP: Overheat protec-
tion, AC: AC input voltage drop, COMM: Internal communication error

*1. You can determine which protection function (hardware or software) was activated with the
background color.
Orange indicates that a PMX series protection function was activated.
Yellow indicates that a Wavy protection function was activated.

The PMX Series is standing by until the specified time to execute the 
sequence is reached.
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Displaying Monitors

You can have the monitored values and the monitor graph displayed in the [Run] window. 

Click on the [Sequence] menu and select the [Monitoring Setup], or click  on the toolbar. The

[Monitoring Setup] window opens.

Displaying the monitored output values in the [Run] window

To display the output values in the [Run] window, select [Current] and/or [Voltage] under [Select
Items to be Monitored].



SD025-PMX Wavy for PMX 31

Displaying Monitors

Displaying the monitor graph

To display the real-time monitor graph, select the [Display the monitor graph] check box under
[Select Items to be Monitored]. Further, additional tabs — [Monitor Graph] and [Setting/Monitor
Graph] — are displayed in the [Run] window.

On the [Setting/Monitor Graph] tab, both setting graph and real-time monitor graph are displayed.
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You can set which graphs (current, voltage, and power) are displayed on the real-time monitor
graph by clicking [Sequence] and then [Monitor Setup], and using [Select Items to be Monitored].

If you move the pointer over the graph, the monitored value will be displayed.

Click the tab to show in the window.

Real-time Monitor Graph
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Changing the Real-Time Monitor Graph Scale

You can change the scale on X-axis and Y-axis in the real-time monitor graph.

To change the scale, right-click on the real-time monitor graph and select [Scale] from the context
menu. The [Scale] window opens.

If you select the [Maximum time], [Maximum current], [Maximum voltage], or [Minimum Value]
check box, the auto scaling function is enabled. While the auto scaling function being enabled, the
scale is  automatically adjusted according to the monitored values.

When the auto scaling function is disabled, the monitored value beyond the range does not appear
in the graph.

When the maximum time is set to be automatically scaled

When the [Auto] check box of [Max time] is selected, you can specify either [Roll mode] or [Normal
mode].

 Roll mode

The X-axis and Y-axis are simultaneously scaled. The display range is defined by subtracting the
minimum time setting from the maximum time setting.

 Normal mode

In normal mode, the minimum time is fixed to a given value whereas the maximum time is
scaled.

When the [Scrolling within the specified range] check box is selected, the graph is scaled when
the monitored value exceeds the maximum time on the X-axis. In this case, the time range to be
scrolled is defined by subtracting the minimum time setting and the scrolling time from the
maximum time setting.

For example, if the minimum time is set to 0 s, the maximum time is set to 23 s, and the scroll
time is set to 10 seconds, the time range will be 13 s (calculated from 23-0-10).
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Changing the Monitoring Interval

You can set the interval for monitoring.

To change the monitoring interval, click on the [Sequence] menu and select [Monitoring Setup], or

click  on the toolbar. The [Monitoring Setup] window opens.

Under [Select Items to be Monitored], set the [Monitoring Interval] to a value between 200 ms and
600000 ms.
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Saving Monitored Data

You can save the monitored data in a text format.

To save the monitored data, click on the [Sequence] menu and select the [Monitoring Setup], or

click  on the toolbar. The [Monitoring Setup] window opens.

Select [Yes] under the [Save File], and specify the destination to save the file.

 p. 39
The given file name concatenates the operating mode, the starting date and time of the execution,
and the file extension. You can change the file extension (.txt by default).

You can set the unit of elapsed time to be written to the file. The accuracy of the elapsed time
depends on your PC environment.

[s]: Seconds

[h:min:s]: Hours, minutes, seconds

If you select the [Data right before Run] check box under [for Saved Data], “0 s” will be written to the
beginning of the saved data file (“0 s” would be regarded as the value monitored prior to the
sequence execution). If the [Data Immediately after End/Stop] check box is selected, the monitored
values after the sequence is completed or aborted will be appended to the saved data.

Under [Order for output to file], you can set the order in which the monitored data (time, voltage,
and current) is written to the file.

 Viewing the saved data

You can open the saved file in Notepad.

 p. 39
By default, the data is saved as tab-separated values. You can select comma-separated values in
the [Environment Setup] window.
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Other Settings

Setting the resolution of the steps to be created by drawing

You can set the resolution of the steps to be created by drawing in the [Graph] window.

Right-click on the [Graph] window and select [Resolution of setting value] from the context menu,
then point to the desired resolution ([Default], [1st digit of integer], [1st digit of decimal place], [2nd
digit of decimal place], or [3rd digit of decimal place]). Default is [3rd digit of decimal place].

Always using the step transition mode when creating the steps 
by drawing

You can restrict the transition mode to “step” when creating the steps by drawing in the [Graph]
window.

Right-click on the [Graph] window, and then select [Draw sequence by step].

Changing the unit of time in the real-time monitor graph

You can change the unit of time ([s] or [h:min:s]) in the real-time monitor graph.

Right-click on the real-time monitor graph and select [X-axis Unit] from the context menu, then
point to the desired unit. Select [s] for seconds, or [h:min:s] for hours:minutes:seconds.

Setting the maximum data size

Executing a long sequence increases the data displayed on the real-time monitor graph, which
increases the load to PC and causes the PC to malfunction. By setting the maximum data size, you
can reduce the load to PC.

Even if you set the maximum data size, all monitored data will be saved.

Right-click on the real-time monitor graph and select the [Max Data Count]. The [Maximum number
of data] window opens.

Enter the value between 10 000 to 1000 000. (The default value is 100 000).

When the size of the monitored data exceeds the set value, the oldest data will be deleted and the
data size will be restricted to be within the maximum data size.

A single monitored data uses approximately 200 bytes.

It is recommended to watch the physical memory amount in the Task Manager while executing a
long sequence.
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Other Settings

Changing the graph display

You can change various settings for the setting graph and the real-time monitor graph.

Setting the items (current or/and voltage) to be displayed on the 
monitor graph

You can set the item (current or/and voltage) to be displayed on the real-time monitor graph.

Right-click on the monitor graph and select the [Line Display], then point to the item to be dis-
played.

Showing and hiding the step-division lines

• [Graph] window

To show/hide the step-division lines in the [Graph] window, click on the [Graph] menu and

select [Vertical Axis] or click  on the toolbar. 

Also, you can right-click on the [Graph] window and select [Vertical Axis] to toggle the display
of the lines.

• Setting graph in the [Run] window

To show/hide the step-division lines in the [Run] window, right-click on the setting graph and
select [Vertical Axis]. 

Changing the scale of X-axis and Y-axis 

You can change the settings for X-axis and Y-axis scales. You can show/hide the scales, specify the
line type (solid or dotted) and the number of lines (grid).

 Showing and hiding the scales

• [Graph] window

To show/hide the scale, click on the [Graph] menu and select either [X-axis Scale Lines] or [Y-axis
Scale Lines], or right-click on the [Graph] window and select [X-axis Scale Lines] or [Y-axis Scale
Lines] from the context menu.

• [Run] window

To show/hide the scale, right-click on the graph in the [Run] window and select the [X-axis Scale
Lines] or [Y-axis Scale Lines] from the context menu.
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Other Settings

 Setting the line type (dotted or solid) and the grid

• [Graph] window

Click  on the toolbar. The [Scale] window opens.

To vary the grid, enter the number in [Number of scale lines].

To set the line type to be dotted, select [Dot] check box. When the [Dot] is not selected, the line
will be solid.

• [Run] window

Right-click on the graph in the [Run] window and select [Number of scale lines]. The [Scale
lines] window opens.

To vary the grid, enter the number in [Number of scale lines].

To set the line to be dotted, select [Dot] check box. When the [Dot] is not selected the line will
be solid.

Changing Y-axis value displayed when the pointer is over

When you move the pointer over X-axis or Y-axis on the real-time monitor graph, the monitored val-
ues for X-axis or Y-axis are indicated. 

To change the Y-axis value to be indicated, right-click on the monitor graph and select [Y-Axis
Value], then point to either [Current] or [Voltage].
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Other Settings

Changing the graph color

You can change the color of the setting graph and the real-time monitor graph.

To change the graph color, click the [Graph] menu and select [Color], or right-click on the graphs in
either [Graph] or [Run] window and select [Color] from the context menu. Depending on the item,
the ways to change the color slightly vary.

Resetting the graph colors

You can reset the graphs colors you changed back to the default conditions.

On the [Setting] menu, click [Environment Setup] to display the Environment Setup window.

To reset the colors, select the [Return to defaults] check box, and click [OK].

[Graph] menu 
*1

[Graph] window 
*2

[Run] window:

Setting graph*3
[Run] window: 

Monitor graph*4

Background Background color Yes Yes Yes Yes

Line Setting line Yes Yes Yes —

Line to Draw Line being created Yes Yes — —

Vertical Axis Line being created Yes Yes — —

X/Y-axis X-axis and Y-axis Yes Yes — Yes

XY-axis scale lines Grid lines Yes Yes — Yes

Line to Run
Line indicating the 
sequence point in 
progress

— — Yes —

Current line Output current line — — — Yes

Voltage line
Output voltage 
line

— — — Yes

*1.Click on the [Graph] menu and select [Color].

*2.Right-click on the [Graph] window and select [Color].

*3.Right-click on the [Setting Graph] tab in the [Run] window and select [Color].

*4.Right-click on the [Monitor Graph] tab in the [Run] window and select [Color].
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Other Settings

Changing the sequence data file format

To change the sequence data file format, click on the [Setting] menu and select [Environment
Setup]. The [Environment Setup] menu opens.

Select either [Tab Separation] or [Comma Separation] under [Sequence Data File Format (*.wvy)]. 
By default, [Tab Separation] is selected.

Changing the monitor output data file format 

To change the monitor output data file format, click on the [Setting] menu and select [Environment
Setup]. The [Environment Setup] menu opens.

Select either [Tab Separation] or [Comma Separation] under [Monitor Output Data File Format]. By
default, [Tab Separation] is selected. Also, you can specify the file extension (txt / csv / log). To spec-
ify the file extension, select the desirable extension from the drop-down menu or enter the name.



40 SD025-PMX Wavy for PMX

Other Settings

Turning the sound on and off

You can turn on or off the sound that is generated when an event (e.g., test execution, completion)
occurs.

On the [Setting] menu, click [Environment Setup] to display the Environment Setup window.

To turn on the sound, select the [Use sounds to indicate operation execution] check box.

Arranging the [Graph] window and the [Worksheet] window

To arrange the [Graph] window and the [Worksheet] window, click on the [Window] menu and
select [Cascade], [Tile Horizontally], or [Tile Vertically].
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Controlling the PMX series directly

You can use the direct control window to remotely control the PMX series’ voltage and current set-
tings, the output on/off state, and the monitor.

To remotely control the PMX Series, click on the [Tool] menu and select [Remote Control Panel]. The
[Remote Control Panel] window opens.

The maximum values that you can enter are limited to the rated output of the connected PMX
series x 105 %.

 Voltage Setting and Current Setting

Enter a value in [Voltage] and click [Set]. Likewise, enter a value in [Current] and click [Set].
These settings are transmitted to the PMX Series. The up and down arrow keys to the right of
the numeric boxes change the values in 1 V or 1 A steps.

If you enter a value in [Step] under [Step Setting], you can adjust the voltage and current by
clicking [Up] or [Down].

 Output

Click [ON] to turn on the output. Click [OFF] to turn off the output. The present status of the
PMX Series will be displayed in the indicator above those buttons.

 Alarm Clear

Click [Clear] to clear the alarm that occurred.

 Result

The response from the target PMX series is displayed.

 Monitor

Click [Run] to start monitoring. Click [Stop] to stop monitoring. The elapsed time is indicated
during monitoring. 
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Controlling the PMX series directly

When monitoring is in progress, Wavy also monitors the activation of the PMX series’ protection
functions. When a protection function is activated, the status appears next to [Status]. The acti-
vation of protection functions is not monitored when monitoring is not in progress.

While the monitoring being stopped, you can set the monitor interval.

To save the monitored output data to a file, select [Save File] check box under [Setting]. To spec-
ify the file destination and the unit of the elapsed time written to the file, click [Folder] under
[Setting]. The accuracy of the elapsed time varies depending on your PC environment.

[s]: Seconds
[h:min:s]: Hours, minutes, seconds

The file name concatenates the operating mode, the start date and time of the execution, and
the file name extension. You can change the file extension (.txt by default).
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Using Commands to Control the PMX Series

You can transmit the commands to the PMX Series directly from Wavy for PMX.

Click on the [Tool] menu and select [Command Control]. The [Command Control] window opens.

Enter a command and click [Run].

Then, the result will be displayed.

The transmitted commands (successfully transmitted and received commands only) appear as list
items in the drop-down menu. To clear the list items, click [Clear]. 

For details about the commands, see the PMX Series Communication Interface Manual.
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About Operating Modes

The PMX Series functions as a constant-voltage source or a constant-current source. In constant-
voltage (CV) mode, the PMX Series holds the output voltage to a certain value regardless of the
load change. Whereas in constant-current (CC) mode, the PMX Series holds the output current to a
certain value regardless of the load change. These operating modes are determined by the follow-
ing three factors.

Output voltage setting (Vs)

Output current setting (Is)

Load resistance (RL)

The figure below explains the operating modes.

The load resistance is denoted as “RL”. The resistance, which is calculated from the voltage and cur-
rent settings (RC=Vs/Is), is denoted as “Rc”. The PMX Series is designed to function in CV mode
within A range, and function in CC mode within B range. A and B are divided by the “RL=Rc” bound-
ary line. On this boundary line, the output voltage equals the voltage setting, and the output cur-
rent equals the current setting. When the load resistance RL is greater than the resistance Rc, the
PMX Series operates in CV mode as the operating point (p point) lies within A range. In this case, the
current setting (Is) equals the current limit.

While the PMX Series is operating in CV mode, the output voltage is hold to a certain level. Output
current “I”, on the other hand, is determined by the equation I=Vs/RL and is lower than the current
limit “Is”. The flowing current may not equal the current setting.

For the loads in which transient peak current flows, the current limit “Is” needs to be set higher than
the peak value.

In contrast, when the load resistance RL is lower than the resistance Rc, the PMX Series operates in
CC mode as the operating point (q point) lies within B range. In this case, the voltage setting (Vs)
equals the voltage limit.

While the PMX Series is operating in CC mode, the output current is hold to a certain level. Output
voltage “V”, on the other hand, is determined by the equation V=Is/RL and is lower than the current
limit “Vs”. The flowing voltage may not equal the voltage setting.

For the loads which causes the transient voltage surge, the voltage limit “Vs” needs to be set higher
than the voltage surge.

Crossover point

The operating modes (CV or CC) automatically switches due to the changes in the load. A crossover
point is referred to as the point where the operating mode switches.

For example, if the load changes and the output current reaches to its limit while in CV mode, the
PMX Series switches to operate in CC mode for protecting the load. Likewise, if the output voltage
reaches its limit while in CC mode, the PMX Series switches to operate in CV mode.
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Is = Current setting
Rc = Vs/Is (Ohm’s Law)
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About Operating Modes

CV/CC modes operation example

The following cases take the PMX Series with rated output voltage 100 V and rated output current
10 A as examples.

First, assume that 8 Ω load resistance (RL) is connected to the output terminals of the PMX Series,
and the output voltage and output current are set to 30 V and 5 A respectively. In this case, the PMX
Series operates in CV mode because RL (8 Ω) is greater than Rc (Rc=30 V/5 A=6 Ω). You can still raise
the voltage up to 40 V (calculated from Vs = ls x RL, that is, Vs = 5 A x 8 Ω = 40 V) in CV mode. If you
attempt to raise the voltage any further, however, the voltage reaches to the crossover point and
the PMX Series automatically switches to operate in CC mode. To allow the PMX Series to continue
operating in CV mode, raise the current limit.

Next, assume that 5 Ω load resistance (RL) is connected to the output terminals of the PMX Series,
and the output voltage and output current are set to 30 V and 5 A respectively. In this case, the PMX
Series operates in CC mode because RL (5 Ω) is lower than Rc (Rc=30 V/5 A=6 Ω). You can still raise
the current up to 6 A (calculated from Is=Vs/RL, that is, Is=30 V/5 Ω=6 A) in CC mode. If you attempt
to raise the current any further, however, the current reaches to the crossover point and the PMX
Series automatically switches to operate in CV mode. To allow the PMX Series to continue operating
in CC mode, raise the voltage limit.
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Menu Reference

Menu Description

File (F)

New*1 Creates a new file.

Open*1 Opens an existing file.

Save*1 Overwrites the file that you are working on.

Save As Saves the file with a new name.

Close Closes the file.

Recent File
Shows up to four paths to the recently opened sequence data files 
(.wvy extension).

Exit Exits Wavy for PMX. 

View

Toolbar Shows/hides the toolbar.

Status Bar Shows/hides the status bar.

Save Position Saves the present position and size of the window.

Previous File Loads the last file that was used when the software starts.

Graph 

Transition
Ramp Changes the transition of the selected line to “ramp”.

Step Changes the transition of the selected line to “step”.

Delete Deletes the selected line.

Vertical Axis*1 Shows/hides the vertical axis.

X-axis Scale Lines Shows/hides the X-axis grid

Y-axis Scale Lines Shows/hides the Y-axis grid

Scale*1 Changes the scale of X-axis and Y-axis.

Color...

Background... Changes the background color of the graph.

Line... Changes the step line color.

Line to Draw Changes the line color being drawn.

Vertical Axis Changes the vertical axis color.

X/Y-axis Changes the color of X-axis and Y-axis.

XY-axis scale lines Changes the color of X-axis and Y-axis grid lines.

Display the graph Shows or hides graphs.

Resolution of setting 
value

Default Changes the setting resolution by dragging.
The default value is three decimal places.1st digit of integer

1st digit of decimal place

2nd digit of decimal place

3rd digit of decimal place

Draw sequence by step Draws graphs using steps regardless of the [Transition] setting.

Copy Copies the graph to the clipboard.

Update Auto Scale Applies the auto scaling to the graph.
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Menu Reference

*1 A button with the same function is available on the toolbar.

Worksheet

Select All Selects all cells.

Undo*1 Cancels the previous operation.

Delete*1 Deletes the step data.

Copy*1 Copies the step data.

Paste*1 Inserts the copied step data.

Sequence 

Run*1 Executes the sequence.

Mode*1 Sets the sequence mode and the operating mode.

Monitoring Setup*1 Configures the monitor settings to be used while the sequence 
being executed.

Protection Setup Sets OVP, OCP, UVP, and UCP.

Setting

Interface Configures the interface to connect to the device.

Environment Setup Sets the file format.

Tool

Remote Control Controls the connected device directly.

Command Control Controls the connected device by using commands.

Window

Cascade Cascades the windows.

Tile Vertically Tiles the windows in the vertical direction.

Tile Horizontally Tiles the windows in the horizontal direction.

Arrange Icons Arranges icons along the window frame.

Help

Help Topics Opens the help file.

About Wavy*1 Displays the application software information including the version 
and the copyright.
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Menu Reference
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